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What is 
PhotoShop 
Elements 7? 

PhotoShop Elements 7 is a version of the popular Photoshop Elements 
program that allows you to make changes to images.  What kinds of 
changes?  Almost anything you can imagine!  At the simple end, you can 
adjust the brightness, colors, and contrast.  At the more complicated end of 
things, you can paint, copy, paste, blur, distort, and even alter the 
photograph to look like a painting. 

How do I get 
started? 

Click on the Start button in the lower left corner, go to the Programs 
option, and in the list that appears find PhotoShop Elements 7. (It may be 
in a folder labeled Adobe.) 

The Opening 
Screen 

The first window that appears will look like this – 
 
 
 
 
 
 
 
 
 
 
 
 
The large image will vary – it’s sort of an advertisement for new 
functions in Photoshop Elements.  What doesn’t change is the four 
buttons across the top that look like this: 
 
 
 
 
The Organize button opens the picture catalog function of Photoshop 
Elements.  The Edit button opens the image editor (where you will 
spend the most time).  Create opens the Organizer with selected 
project options such as slide shows, collages, and so on. Share opens 
the Organizer with selected sharing options such as uploading images 
and burning CDs. 
 
For now, select the Edit button. 
 

Introduction to PhotoShop Elements 7 
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What are all 
those boxes on 
the screen?! 

PhotoShop uses a variety of small windows to display 
information and controls for the various tools in the program.  
These are called “palettes” and “bins.”  Photoshop Elements 
has gotten more restrained in the use of them, so the screen 
isn’t as cluttered as older versions were.  
 
For now, we’ll just leave them all as they were when you opened the 
editor.  It should look like this: 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
Before we look at what any of these tools do, however, you need to 
open a file to work on.  Go to the File menu, and select Open. 
 
Find a file that you want to open.  For starters, let’s go to Samples II 
CD, and open the totem1.jpg file. 

How do I make 
overall 
adjustments to 
the picture? 

To start making adjustments to the whole picture, go to the Enhance menu.  
You’ll see a set of selections that looks like this. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The first six options will 
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automatically adjust your 
picture for a variety of issues.  
Auto Smart Fix tries to fix 
colors and lighting in one jump. 
Auto Levels works on light and 
shadow, while Auto Contrast 
affects the contrast.  Auto Color 
Correction, Auto Sharpen and 
Auto Red Eye Fix do what the 
names imply. 
 
It’s worthwhile trying these tools.  Sometimes they help, sometimes they 
don’t.  If something doesn’t work out right, you can always go to Edit and 
select Undo.  (I do that a lot!) 
 
Adjust Smart Fix gives you some control over how much change the 
computer makes to your picture. It presents you with a slider that can make 
the effect more intense. 
 

What are the 
Adjust Lighting 
options? 

Things get more interesting with Adjust Lighting and Adjust Color.  
Selecting Adjust Lighting gives you these options: 
 
 
 
 
Shadows/Highlights is for fixing images where the background is too bright 
or the shadows are too dark.  It gives you a control that looks like this: 
 
Lighten Shadows makes darker areas 
of the image brighter. Notice how it 
brings out the detail in the carving on 
the totem pole as you move the slider 
to the right. 
 
Darken Highlights makes brighter 
areas darker. It will darken the sky. 
 
Midtone Contrast increases the 
contrast for middle-range colors. 
 
When you have finished tweaking the picture, click OK. 
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 Brightness/Contrast lets you 

adjust the overall brightness and 
contrast of your image.  
Brightness lightens the whole  
picture.  Increasing the Contrast 
makes dark colors darker and 
light colors lighter; decreasing 
the Contrast makes all colors 
faded. 
 

 Levels is similar to the previous tools but works a little differently.  It 
gives you a little more control as you adjust the brightness of your 
image. 
 
Once you select Levels, you’ll get a somewhat intimidating window that 
looks like this: 
 
 
 
 
 
 
 
 
 
For now, we’ll just worry about these little arrows. 
 
Moving the black arrow to the right will make the darker colors darker. 
Moving the white arrow to the left will make the lighter colors lighter.  
Moving the gray arrow to the left will brighten the mid-range colors, while 
moving it to the right will darken them.  
 
The eye droppers are another way of controlling the levels.  
If you select the black eyedropper and click on any spot on 
the image that should be pure black, it will adjust the color 
range of your picture to make that spot (and similar colors 
throughout the picture) pure black.  The white eyedropper 
does the same thing for white areas.   
 
The middle eyedropper is for a neutral shade of gray.  If you select a spot 
that should be a mid-level of gray, it will adjust all the colors in the 
image.  This works really well for older pictures that have a shifted 
colors.   
 

What are the Remove Color Cast will help you adjust a 
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Adjust Color 
 options? 

picture that has an overall color problem. 
 
Adjust Hue/Saturation adjusts the color 
range and color intensity of your image.  
 
 
 
Selecting this option gives you these controls: 
 
Sliding the Hue left and right shifts all 
the colors in the image to bizarre hues. 
 
Moving Saturation to the right makes the 
colors more intense, even unnatural.  
Moving the slider to the left fades the 
color intensity.  It can make the image 
look like a faded old color photo, or even 
make it black and white. 
 
Remove Color turns a color picture into a black-and-white image. 
 
Replace Color lets you pick one of the colors in your image and change it to 
another color. 
 
Adjust Color Curves the intensity of the colors within certain ranges; the 
samples in the control panel give you present controls, or clicking on 
Advanced Options will let you explore on your own. 
 
Adjust Color for Skin Tone will let you tell the computer what part of the 
image should be skin tone, and it will adjust the entire image to make the 
skin tones look natural. 
 
Defringe Layer is a control that you can use if you are cutting and pasting 
different images together.  Each new item will go into a layer (more on this 
later).  Sometimes there are fuzzy edges to a layer when you do this; 
Defringe Layer tries to remove the annoying fuzzies. 
 
 
 
 
 
 
 
Color Variations gives you a display that looks like this: 
 
To adjust your color, look at 
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the samples across the 
bottom and select the one 
that looks the closest to the 
way you want your picture 
to look.  You can also 
choose whether you are 
adjusting just the Midtones, 
Shadows, or Highlights. 
When you are done, select 
OK.  
 
If things get messy, you can select Reset Image and start over. 
 

What if I’ve 
really messed 
things up? 

If you made a total mess of your image, 
go to Edit and select Revert. It will 
reset your picture to the last saved 
version. 

 
What does 
Quick Fix do? 

Quick Fix gives you access to all the main image enhancements in one 
screen.  Switch this on in the upper left-hand corner of your screen. 
 
 
 
 
This will open a screen that looks like this: 
 
 
 
 
 
 
 
 
 
 
 
 
The first thing I recommend is selecting a different View.  Click on the 
button in the lower left-hand corner and select one of the Before and 
After views. (It doesn’t matter which one.)  This will let you compare 
the changes you make to the original. 
 
 
The buttons on the left let you select which aspect 
of the picture that you want to correct. Some of 
these are the same fixes that were under the 



T3 – Puget Sound ESD Photoshop Elements 7 Page 7 

Enhance menu, and some are subtly different. 
 
Under General Fixes, Smart Fix and Red Eye Fix 
are the same as above. 
 
Under Lighting, Levels and Contrast have only the 
“Auto” option. Lighten Shadows, Darken 
Highlights and Midtone Contrast are the same as in 
Shadows/Highlights. 
 
Under Color, Saturation and Hue work the same as 
in Adjust Color above.  Temperature shifts the 
overall color from blue to red, and Tint shifts the 
overall color from green to magenta. 
 
Sharpen gives the illusion of sharper focus.  Use 
it sparingly, or it starts to look pretty ugly. 

What are the 
symbols on the 
tabs? 

As you make changes to your picture, the tabs down the side will display 
symbols.  For instance, the Lighting tab will change like this: 
 
Before making edits 
 
 
After making edits  
 

The first symbol  is Undo and will remove the changes you have made. 
 

The second symbol  is Accept and will keep the changes. 
 
The little light bulb opens the Help file. 
  

Why don’t the 
symbols appear 
if I use the Auto 
functions? 

For some reason, the little symbols don’t appear if you use the Auto fixes.  
If you want to undo those changes, you need to click the Reset button above 
the upper left-hand corner of the picture. 
 
Unfortunately, this resets the whole picture, 
including any changes that you made with 
other Quick Fix tools.  No, I don’t know why 
this is.  
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When you are done with all of your adjustments, click Standard Edit in the 
upper right-hand corner.   
 
 
 
 
 
This will save all adjustments you have made. 
 

Opening the 
Navigator 

 An important palette for editing your picture is 
the Navigator palette. Go to the Window menu 
and go down to Show Navigator. 
 
That will open a window that looks 
like this: 
 
 
 
 
 
 
 

 Moving this slider will zoom you in and out of 
the picture. (You can also just click on the 
magnifying glasses.) 
  

How do I 
control which 
part of the 
picture I’ve 
zoomed in on? 

If you zoom in on the picture using the Navigator, you’ll zoom in dead 
center.  If you look at the Navigator palette, however, you’ll see a small 
red square in the preview window. 
 
If you click on the square you can 
drag it around, and that will 
change which part of the image 
you see in the main window. 
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The Main Tool 
Palette 
 

On to the main tool palette!  That’s the box on the left side of the screen 
that looks like this. 
 
 
 
I’m not to explain every single tool here.  (That’s what 
the manual is for!) I will cover the most important.   
 
 
Many of the tools have a small triangle in the lower left 
corner.  This means there is more than one tool in that 
part of the palette; click and hold on it for the others to 
appear. 
 
Click and hold on  
 
And you will see  
 
 
 
 

How do I select 
just one area of 
the screen to 
adjust (or cut 
and paste)? 

There are four different sets of “selection tools” that let you 
pick one part of the screen.  Once an area is selected, any 
changes that you make with Enhance or other tools will 
only affect the area that you’ve chosen. 
 
Selected areas are defined by having 
sparkling dotted lines around them. 
 
 
 
 

 The Rectangular Marquee Tool lets you 
pick a rectangular part of the screen; the 
Elliptical Marquee Tool lets you select 
ovals or circles.   
 
Clicking and holding on lasso lets you 
choose from these options. 
 
The Lasso Tool lets you choose a freehand selection.  As anyone with 
any experience wielding a mouse knows, tracing around something is 
very difficult.  That’s why you have the choices of the Polygonal Lasso 
and the Magnetic Lasso.  Let’s see how they work. 
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How can I move 
something from 
one picture to 
another? 

Go to the File menu, and open the file totem1.jpg. 
 
If you use the Polygonal Lasso, you define 
the edges of your selection by clicking on the 
edge of the item you want to select, then 
letting go of the button and moving to the 
next spot along the edge.  Think of it as 
drawing a dot-to-dot picture around the edges 
of area. 
 
Tip #1: If you have trouble and want to bail 
out, press the esc key on your keyboard.) 
 
Tip #2: If you use the Magnetic Lasso, you click and drag along the 
edge of the area that you want to select.  The lasso picks up the color 
difference along the edge and places a selection line. It only works if 
there is a distinct color difference, however. 
 
When you have gotten all the way around the totem pole, double-click to 
close the selection.  You’ll see sparkling lines around the pole. 
 

How do I move 
the totem after I 
select it? 

To move the pole, click on the Move Tool. 
 
Then click on the middle of the pole, and drag it until 
your cursor is over the picture of the Mt. St. Helens.  Let 
go, and the pole is in a new location! 
 
(If you can’t see Mt. St. Helens and the totem pole 
at the same time, go to the upper right corner of 
the screen and click the button to turn on Multi-
window mode.) 

How do I move 
the pole around 
in the volcanic 
monument? 

When you dragged the pole to the mountain, it created a new layer in the 
picture.  Layers let you keep the different parts of the picture separate, 
which gives you great control over the image. 
 
Since the pole is in its own layer, you can click on it and drag it around all 
you want.  If the totem won’t move, then you might need to make sure 
you’re working in the right layer.   
 
To do that, open the Layers palette by going to 
Windows and selecting Layers.  
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The Palette Bin will open on the right side of the 
screen, and it will show something that looks like this. 
 
 
 
 
 
 
 
 
 
Notice that the top layer (Layer 1) has a gray highlight.  This means it 
is the active layer.  When you click on the totem, you can move it.  To 
change which layer is active, just click on the name of the layer. 
 

How do I resize 
the totem? 

Go to the Image menu, and go down to the Resize menu.   
 
Select Scale. Click one of the corners 
and drag towards the opposite corner.  
Press Enter when you are done. 
 
Tip:  Holding the shift key will keep the 
image in proper proportions. 
 

What other layer 
tricks can I do? 

You can make a layer transparent by adjusting the Opacity. Click here 
and move the slider to the left. 
 
 
 
 
 
 
 
 

 Clicking this button will change how 
the top layer blends with the layer 
below it.  Experiment and see what 
they do! 
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 You can also apply a variety of effects to a layer using the Artwork and 
Effects.  You can find this option under the Window menu, or in the 
Palettes Bin above the Layers palette. 
 
Click the white arrow to see your 
options. 
 
 
 
Once you open it, you will see something that looks like this 
 
 
 
 
 
 
 
 
 
 
 
 
 
The default choice will be Artwork, with the Frames option selected. 
Clicking on any of these options will create a frame around your picture, 
but only if there is a single layer.  If there are two or more layers, you will 
get a frame with text inside that says this: 
 
Normally you will only use this in an 
image with a single layer, but if you 
want to import an image into a frame 
within a larger image, you could 
follow the directions and place a new 
image in the frame. 
 
There are many frames you can try out.  Click on the drop-down box on 
the left to see the list of frame types. 
 
Don’t worry about messing anything up while 
exploring.  If things go wrong, simply to go Edit 
and select Undo. 
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There are lots of other options, too.  The most 
useful will be in the section called Special Effects, 
the third button across the top. 
 
If you click the dropdown box on the left, you’ll 
see a list of kinds of effects you can try. Filters  we 
will come back to later.  Layer Styles is the one 
with the most interesting options. But note – as the 
name implies, these effects only work in images 
that have more than one layer! 
 
If you click the box on the right, you’ll see a drop-
down that lists many other sets of effects you can 
try on your layer. Bevels make a layer pop up as if 
they have carved edges.  Drop Shadows is one of 
the most used, and gives a cool 3-D effect behind 
layers.  
 
Many of the bottom ones (Glass Buttons, Complex) 
completely obscure the original image in the layer. 
 
 
 

My layer is a 
mess! Help! 

After playing around with all these styles, if your layer is a total mess go 
back to the Layers palette.  You’ll see a little blue-and-white starburst to 
the right of the layer name.  Right-click on the circle and you’ll see this 
menu pop up: 
 
 
  
 
 
 
 
Selecting Clear Layer Style will delete all of your experiments on that 
layer. 
 

How can I 
touch up just 
one part of the 
picture? 

Many of the tools in the palette are for spot changes to your image. They 
only work on a single layer at a time. 
  
Near the bottom of the palette you’ll find 
the Blur, Sharpen, and Smudge tools.  
(You’ll only see one tool on the palette 
unless you click and hold on it.) 
 
The Blur Tool makes the image blurry.  This can soften wrinkles, or 
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make a distracting background out-of-focus. 
 
The Sharpen Tool can  make the image look (a little bit) more focused.  
Use it too much, and it just makes a mess. 
 
The Smudge Tool moves the picture around as if it’s wet ink. This can 
minimize blemishes.  Or just be really fun. 
 

 Right below these tools are the Dodge, Burn, and Sponge tools. 
 
The Sponge tool either increases or 
decreases the color intensity.  Check the 
box in the Tool Options bar across the top  
of the picture.  (More on that later.)  If it 
says Desaturate, it will fade the colors.  If 
it says Saturate, it will make the colors 
more intense. 
 
The Dodge Tool lightens where you paint. 
 
The Burn Tool makes the image darker where you paint. 
 

How do I 
control the tool 
settings? 

Whenever you select any tool, the strip across the top of the image 
changes to show the options for that particular tool.  This is the Tool 
Options bar.  For instance, for the Sponge tool, it looks like this: 
 
 
 
For this tool, the most important controls are the brush size and shape, 
and the “mode.”  Each tool will have different settings, although almost 
all of them have the brush size and shape controls. 

How can I fix a 
scratch or 
other damage? 

The tool for fixing many kinds of damage is the Spot Healing Brush.  
 
 
 
For an example, I have drawn a line to represent a scratch on the totem 
image. 
 
 
 
 
 
When you select the Spot Healing Brush tool, the 
cursor will change to a circle shape, indicating a 
brush.  Use it to paint over the damage.  It will 
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show sparkling lines like a selection tool. 
 
When you let go of the mouse button, it will look 
at the area around the damage, and use it to fill in. 
When this works, it’s pretty cool!  How well it 
works depends on the match between the damaged 
area and the image around it. 
 
There are other adjustments you can make to this tool to change how it 
functions, but I’m not going to go into detail here. 
 

How do I copy 
things from one 
part of the 
picture to 
another? 

One of the most interesting tools in Photoshop Elements is 
the Clone Stamp Tool.  This tool copies one part of your 
picture into another area.  You can use it to fix damage, or 
to do things like increase the number of flowers in your 
image. 
 
I’m going to use the image anemones.jpg.   
 
 
 
After selecting the Clone Stamp Tool, you first 
need to choose the part of the image that you 
want to copy.  To do that, position the cursor 
over the middle of the flower on the left. Next, 
hold down the Alt key (on a Mac, that’s 
Option).  While you hold that down, the cursor 
changes to a circle to a crosshair shape.  
 
While you continue to hold down the Alt key, click once on the center of 
the flower.  You won’t see anything happen. Let go of the Alt key. 

 You have told the computer that the center of the 
flower is where you want to start copying from.  
To begin copying, move the cursor over to the 
right of the flowers. Hold down the mouse button 
and start to “paint.”  You will start to create a new 
flower! 
 
The Clone Stamp Tool has two major ways of 
working.  If you look at the Options Toolbar 
across the top, you’ll see a little box with the 
word Aligned. 
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You want to have Aligned checked if you are copying an object, such as a 
flower.  However, if you are going to copy a pattern, such as grass, you 
want to uncheck it.  With Aligned turned off, as you copy from one area to 
the next, you can reset the pattern just by letting go of the mouse button for 
a moment.  When you begin painting again, it will start from the first point 
you targeted with the Alt-click. 
 
Use All Layers will let you copy from one layer in the image into another 
layer. 
 
(Yes, this is confusing.  No, it’s not just you. This is one of those things that 
you have to try and repeat several times before it starts to make sense.  
However, when you get the hang of it, this is one of the most powerful tools 
you can use.) 
 

How do I add 
text to my 
image? 

The large black letter T on the toolbar is the Text Tool.  
 
 
Once you have selected the tool, next look at the Options Toobar across the 
top of the screen. 
 
 
 
Select the font, style, and size of your text 
with these drop-down boxes. 
 
Select the color of your text with this box. 
 
Once you have made your choices with these options, position your cursor 
over the part of the picture where you want the text, and click.  Then you 
can begin typing. 
 

 Your text will be in a separate layer.  This means don’t worry about where it 
ends up while you are typing. 
 
 
 
 
 
 
 
To move the text after you’ve typed it, select the Move Tool. 
Click on one of the letters and drag the text to where you 
want it to go. 
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What about the 
other Tools? 

The Shapes tool will let you create a variety of different 
shapes on your image.  Each new shape you create will be in 
a separate layer.  The color of the shape will depend on the 
Foreground color.  After you have created your shape, be 
sure to select Simplify in the options bar across the top of the 
screen if you want to modify the shape. 
 
The Paint Bucket tool will take the Foreground color and fill 
areas of color on your image. 
 
The Gradient Tool will fill your image with a range of 
colors.  The gradient and style is controlled in the Options 
bar across the top of the screen. Note: It will fill your whole 
picture and cover anything already in that layer! 
 
The Brush/Pencil Tools let you paint or draw on the image.  
You have a wide variety of brush shapes and sizes to choose 
from in the Options bar.  The Impressionist Brush makes 
your image look like an impressionist painting. The Color 
Replacement Tool lets you paint over one color with a 
different color. 
 
 

 There are three Eraser tools.  The 
Eraser just erases.  (The color it leaves 
is the “background” color.) 
 The Background Eraser, properly used, 
parts of the picture you don’t want and 
leaves the parts that you do.  It watches 
the color you first start erasing, and tries 
to ignore other colors.  (Adjust the 
Tolerance down to make it more 
“selective.”) 
The Magic Eraser will remove whole areas based on color. For instance, 
if you click in blue sky, it will erase all parts of the sky with a similar 
shade of blue. 
 

How do I 
control the 
colors? 

The colors of these tools are controlled by the 
Foreground/Background color tool at the bottom of 
the toolbar.  The top box is the Foreground color, 
which is the color that the tools above will paint on 
your picture.  The bottom box is the Background 
color, which is the color that the eraser will leave, or 
that will be left if you delete part of your picture. 
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If you’d like to select different colors for the 
Foreground/Background colors, click on the colored 
box that you want to change. 
This will open a somewhat confusing box called the Color Picker.  It 
takes two steps to select your color. 
 
 
 
 
 
 
 
 
 
Step 1 is to pick the hue of your color by moving 
this slider up and down. 
 
You’ll notice that the color in the large box 
changes as you move the slider up and down. 
 
Note the little box that now has two colors in it in 
the upper right. The color on the bottom is the 
color you started with, and the color on top is the 
color you have currently selected. 
 
If the shade in the upper box isn’t quite what you’re 
looking for, look in the large color box.  You’ll see a 
little circle.  Move it around in the large box until you 
have the right brightness or darkness for the color 
you want.  Then click OK. 
 
 
 
 
 
 

Where can I 
find info that 
isn’t in the 
handout? 
 
 
 
 

Photoshop Elements has an extensive help section.  To access it, click 
the little question mark in the upper right-hand corner: 
 
 
 
 
 
Many of the tools have blue hyperlinks in their names.  If you click 
these links, they will open up that portion of the help section. 
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There are also some mini-tutorials under How To in the Window menu 
or in the Palette Well.  
 

What are Filters 
and how can I 
use them? 
 
 
 
 
 
 
 
 
 
 

There are many special effects called Filters that 
you can apply to your pictures.  They will affect 
only one layer, or any area that is selected.  
There are two ways to get to the Filters.  If you 
like to see a preview to help you select, then you 
should go back to the Styles and Effects palette 
and select Filters: 
 
You will see a long display of images that looks like 
this.  Each one represents a different Filter and what 
it looks like when you apply it.  There are several 
dozen of them.  It’s a long list, so you will need to 
scroll down to see all of them.  Which, of course, you 
have to do. 
 
Once you find one you want to try, double-
click it. 

 If you choose Accented Edges, and it gives this window.   
 
I find this window kind of busy, 
so to make things a little less 
cluttered, click on this button. 
 
This hides all the previews of 
other filters, and gives a clearer 
view of the filter effects. 
 
 

  
 
 
The screen now looks like this: 
 
 
 
 
 
 
 
The controls down the right side adjust the effect of the filter.  
They can vary the results quite dramatically.  If you like the 
effect, click OK.  If you don’t, click Cancel. 
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How many 
filters can I 
use? 

There is no limit on the number of filters you can use on the 
image.  Photoshop junkies often use many different filters on a 
single picture to create the look they want.  Even repeating the 
same filter multiple times can create unusual results. 
 

The filter 
preview was 
black and white, 
but my picture 
turned different 
colors.  How 
come? 

A number of the filters (such as Bas Relief and Charcoal) appear 
black and white in the previews, but then strangely appear in 
different colors when you preview or apply them. 
 
This is because the colors of the filters are set by 
your Foreground  and Background colors in your 
tool bar.  These are the two little boxes at the bottom 
of the toolbar discussed on page 15. 
 

 For instance, if you choose the Chalk  filter, the color of the “chalk” 
in the picture will be the Foreground  color, and the color of the 
“paper” will be the Background color. 
 
You can change the colors as described above, or 
you can reset the colors to just black and white. 
To do this, click on the little black and white 
boxes in the lower left corner. 

Why don’t the 
filters work? 

Filters only work on the currently active layer, or in areas of the 
picture that have been selected.  Make sure you’re in the right layer, 
and make sure there isn’t an active selection by going to the Select 
menu and checking Deselect. 
 

 
 
 
 
 
 
Notes 
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